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1. DOWNLOAD SOFTWARE

When you create a photo book with us you can choose whether you create online, or you can create

with our downloadable editor. When you create online, your photo book is saved on the Photobox

servers, and enables you to login from anywhere in the world.

When you create with our downloadable editor, you will need to download our software. This editor

offers you the most creative options, enables you to work offline, and saves the project to your local

drive.

This guide deals with our Windows downloadable editor.

Click on the link https://photobox.co.uk/photo-books/creator. >>

Select “Download for Windows“.

Your download should start automatically (it will appear in your downloads folder) and the following

will show:

Thank you for downloading!

You’re ready to install the Photobox photobook software.
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All done. These are all the instructions you need to install our Photobox software. Let's get started!
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2. DESIGN YOUR FIRST PHOTO BOOK

First, go to “Photo Books” and choose what type of photo book you want to create. You have several

options:

- Size: S, M, L, XL (depending on the type of book)

- Format: landscape, portrait, square

- Cover: hardcover or softcover

To illustrate, we’ll opt for the square XL photo book with a size of 30 x 30 cm, hardcover. There are

more options to choose from, as you will see in the next step.

Click on the photo book of your choice. A pop-up window will appear, giving you three options to

start designing your photo book.

1. Create yourself: start with a blank canvas and put your book together yourself.

2. Smart Assistant: our Assistant will help you fill your book with photos quickly and automatically.

3. Choose one of our many professionally pre-designed photo books, add your own photos and

tweak the book according to your wishes.
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First select “Create yourself” and the new empty book will open.

- You can now choose the binding. If you opt for lay-flat premium (at an additional cost), your

photo album is bound in a way that allows the left and right pages to flow together

seamlessly. The standard binding, as with regular books, has a slight curve where the pages

are glued together in the middle. This means that a small part of the image is not visible

along the seam in the middle.

At the bottom of the page you will see how much your photo book is going to cost. The price varies

according to your chosen options and the minimum page number. The amount will automatically

update every time you add more pages to your book.

3. THE PHOTOBOX START PAGE
This is what it looks like – a photo book with 24 blank pages and the blank front and back cover (this

is because we selected a photo cover for this example). The software has already pre-designed a

layout with photo frames and text fields so you can get started right away. You can deactivate this

option for future photo books via File > Settings > General menu. The gear icon in the horizontal

menu bar at the top will also take you to this settings menu.

It's best to design the photo book cover last because it can change slightly as you add more pages and

the spine of the photo book gets thicker, which may affect your cover design.

Below the edit space you can see an overview of all the pages of your photo book. In the next

chapters the different menus will be explained in the order Photobox uses them. Screenshots will

illustrate their meaning and purpose.
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At the top you will find the horizontal menu bar (1)

and on the left another menu with icons (2).

The horizontal menu contains a comprehensive list of editing options for photos, pages and the entire

book.

The vertical menu with icons on the left lists various items you can add to your photo book: photos,

backgrounds, templates, frames, clip art, shapes, and layouts. We will talk you through the various

icons from top to bottom.

The horizontal menu bar: we’ll now explain the tools on this menu for each tab from left to right.

You will find four submenus in the orange horizontal menu bar at the top of the Photobox software

window:

- File

- Edit

- Photobook & page

- Check & Order
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4. FILE MENU

At the top you’ll find the photo books you have recently created and/or opened (recent). Right-click

on the item to remove photo books from this overview. This will only delete them from this overview,

not from your computer. Below you can select a new photo book.

This guide will explain the different options in this left menu from top to bottom.

4.1. NEW
Opens a new (empty) photo book.

4.2. OPEN
Opens a photo book you've already created.
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4.3. SAVE and SAVE AS…
The most important option is “Save as...”. You have just created a photo book, in order for you to be

able to save this book and not lose any progress on the book you first need to give it a title.

Click the "Save As..." icon. A small screen will appear. Your photo book is now called “Unsaved”.

When you've given the photo book a title and have saved it, the “Save” button will save the latest

version of your photo book. You can save manually at any time but the Photobox software will

request it regularly. You can also set this option yourself via Folder > Settings > General.

4.3.1. OPEN SEVERAL PHOTO BOOKS AT THE SAME TIME

By clicking "plus" next to the active photo book tab, you can open a second and third photo book for

editing. These can be either new or existing photo books. It’s recommended to give new photo books

a title right from the start to avoid confusion.

The big advantage of working on several photo books at the same time is that you can select the

contents of pages from Book 1 and copy and paste them into Book 2. This will save you a lot of time if

you want multiple photo books to have similar pages.

The white tab shows the photo book you are currently working on, i.e. the active photo book. Simply

click the grey tabs to switch between photo books. The title of your photo book will now show at the

top of the menu and also in the tab of the photo book you're working on.
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4.4. SETTINGS

In this menu you can adjust a number of settings.

4.4.1. SETTINGS – GENERAL

Check or uncheck all these boxes according to your needs. It all depends on your personal

preferences.

For example, most users like the smart alignment and find a grid useful when dragging objects.

If you have certain fonts installed on your computer but cannot find them in the Photobox software,

you will need to uncheck the following box: Show only TrueType fonts for text editing.

This is disabled by default, to be on the safe side. Not all fonts look good in printing, and it is possible

the font of your choice may not be easy to read. However, you can check this at any time by setting

the preview to 100% and seeing what the font looks like in context.
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You can adjust other settings, such as how often you want to be reminded to save your book and

whether or not you would like the software to optimise your photos by default. If you're editing all

your photos in Lightroom or Photoshop, you should disable this option.

4.4.2. SETTINGS – ADVANCED

In the advanced settings, you are able to specify how much of your computer's memory the

Photobox software can use while you are working with it. We recommend selecting Average memory

use. This means that the detail in your photos will appear on your screen in reasonable sharpness.

However, this will not affect the quality of your photo book in print.

You can also create and export your page layouts in this menu or import a previously saved page

layout. This is useful if you have a new computer and are re-installing Photobox but still want to reuse

your saved layouts.

You can also view the version history of the software in this menu, to check for any recent updates.
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4.4.3. SETTINGS – TROUBLESHOOTING

You may need to use these options when speaking to customer service if there is a problem with your

photo book or the software.
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4.4.4 IMAGE – ENHANCEMENT

Image enhancement is applied by default to ensure the highest possible print quality. We recommend

leaving this feature turned on and if necessary to remove it on individual photographs using the

menu accessible by right-clicking with your mouse.

When you enhance your photographs using software like Photoshop or Illustrator you don’t need to

enhance your photos any further and you can turn off this option.
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4.5. HELP

When you click “Help”, the Photobox website pops up in a new window where you will be able to

type your question.

4.6. INFORMATION

A window pops up showing the current version of the software (like 24.3.1).

4.7. CLOSE PROGRAMME

This option will close down the editor. You will first receive a warning that any unsaved projects need

to be saved.

5. EDIT MENU

Here, you will find the options you'll use most often when making a photo book. The Edit Menu is

divided into five smaller menus:

1. Clipboard

2. Insert

3. Object

4. Position and size

5. Layout

The smaller menus and their tools explained from left to right.
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5.1. CLIPBOARD MENU

Paste – (on the keyboard: Ctrl + v) – pastes a copied element onto the page you are currently working

on.

Cut – (on the keyboard: Ctrl + x) – cuts a selected element from the page to paste it elsewhere later.

Empty – empties a selected picture frame.

Copy – (on the keyboard: Ctrl + c) – copies a selected element. This is also useful if you want to insert

several elements of exactly the same size, for example. First, copy the original element and paste it

several times. Then move the new photos into the frames.

Remove – removes the selected element from the page.

Undo – (on the keyboard: Ctrl + z) – undoes the last step. Every time you use this keyboard shortcut,

you go back one step.

Redo – (on keyboard: Ctrl + y) – redoes the most recent step.

5.2. INSERT MENU

The “Insert Menu” enables you to insert all kinds of elements on your page. You've already seen

several of these tools in the menu on the side, but the main menu offers even more options.

Each tool from left to right:

5.2.1. TEXT FIELD

Click “Text” to open a text placeholder on your page. Double-click on it to open a new window in

which you can start typing. A format menu also pops up.

In this window you can select the desired font, the size of the text, the style (bold, italic, underlined)

and the alignment of the text block (left, right, centred, expanded, etc.).This is also where you choose

the text colour and the background colour of the text field. You could choose a default colour such as

black or transparent (transparent is the first box in the default colours with the squares in it).
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The colour picker is also a nice option. When you click it, your mouse cursor turns into an eyedropper

and you can use it to select a colour from a photo in your book. This will give you the perfect text

colour to match your photo. When you’re happy with the font and your other chosen options, you

can set it as the default for the rest of your photo book. Click OK to return to your page.

Note: the fonts available for selection in this menu are the fonts installed on your computer and

which come with the software. If you would like to use a different font in your photo book, you will

first have to download it and install it on your computer - more on this later. If you have a font

installed on your computer which doesn't show in the list, follow the instructions in chapter 4.4.1.
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5.2.2. IMAGE

Clicking on this icon will insert an empty image placeholder on the active page. You can then move

your own photo into this placeholder.

To customise the placeholder you simply move the white dots that pop up when you click on the

item. Please note that your photo will be cropped to fit the frame (see image below).

Sometimes it’s better to move the centre of the photo a little if an important part of the photo is cut

off by cropping.

When you click on the image, a white dot will appear in the middle. Use it to reposition the centre of

the photo.

Use the slider below the selected photo to zoom in and click the arrows to swap photos. The pencil

icon will point you to the screen where you can edit the photo (colour, brightness, crop, correct

horizon, etc., see 9.).
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5.2.3. MAP

This option allows you to insert a map into your photo book. Click the option, enter the desired

address, click the magnifying glass (Search) and then click “Apply”. You will be able to choose either a

single address or a route between two or more addresses.
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5.2.4. PHOTO PLACEHOLDER GROUP

This tool allows you to place several image placeholders, already arranged according to a specific

template, with one click. Choose between hexagons, circles, stars or flower masks.

Use the grid to select the desired number of placeholders – per row and per column – and set the

spacing. After positioning the group, you will be able to insert your photos into the placeholders. You

can then move or delete individual placeholders from the group at any time.

If you wish to make the image placeholders larger than their default placement, simply increase the

margin before placement, e.g. to 20. The frames will then appear on the page with plenty of space

between them. Use the shortcut “Ctrl + a” to select all the elements. They will be highlighted with a

blue outline. Next, click on one of them so that white dots appear in the placeholder. Use the white

dots in the corners to enlarge it. The other selected placeholders will also be made larger (or made

smaller) and will adjust to exactly the same size. The distances between the images will become

smaller accordingly.

This is why you need to increase the placement distance so that you will have enough space later to

enlarge the image placeholders without touching or overlapping. As long as you select all picture

frames blue outline), you will be able to move the group as a whole around the page or, for example,

copy or cut and paste them onto another page.
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5.2.5. QR CODE

Add a QR code to your photo book to play videos. Simply scan the code with your camera to open the

video on your smartphone.

How it works: select an online video with a URL. Copy the URL of the video (e.g. a file on YouTube or

in Dropbox) and paste it into the address field of the QR code menu.

In the options, select the desired colour for your code and, if you wish, adjust the background

transparency – zero means the QR code background is white. Click “Save.”

The code will then show on your page.

Tip: If you want to read more about how to post a video on YouTube, click the following link:

https://support.google.com/youtube/answer/57407

When posting/uploading, please pay close attention to the privacy settings of the video you upload:

https://support.google.com/youtube/answer/157177

Please note: the video may not ever be deleted from the original location, otherwise the QR code will

no longer work.
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5.2.6. BACKGROUNDS

This tool allows you to add a background to your page. The black arrow below this menu item

indicates that you can expand this menu to show multiple options. You can select a background

colour or a magical background.

5.2.6.1. BACKGROUND COLOUR

Select “background colour“ to access a colour block menu. Choose a colour (like yellow for example)

or select one of the three other options.

Use the colour picker to select a colour from a photo on your page. In the example below we picked a

brown colour from the fence for the right page background.

Use the “Mix a colour” option to select colours on a scale from dark to light and set them specifically

according to the red/green/blue colour value.

Finally, simply check the box to select “Calculate background colour”. The software will pick a solid

colour to match the photos on your page.

At the bottom of the colour selection window you can then determine whether the colour is to be

applied only on the active page, on all following pages, all following even pages or all following odd

pages.
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5.2.6.2. MAGICAL BACKGROUND

Our software can also create your very own magical background.

To do so, the software picks the most colourful part of the photo, enlarges and blurs it. The result

depends on the photo you choose to create the magical background with.

On both the left and right page pictured below the same pictures are used. The large photo at the top

was selected (and then right click, create magical background) to get the left magical background

result. The middle small picture at the bottom was selected to get the result on the right page.

In this example you can choose which pages you would like to use this background for but

if you want to use the exact same magical background on both pages, do the following:

1. Right-click the magical background on your page.

2. Select “Position > Background as a photo. This will separate the magic background from the

original background.

3. Copy and paste your magical background on the desired page.

4. Now, use the right mouse button to reset the image as background on both sides: Position >

Photo as background.

5. Another option could be to flip one of the backgrounds horizontally (with the right mouse

button).

The procedure mentioned above will also work for regular (not magical) backgrounds.

23

Photobox Windows editor manual - Last modified 12 aug 2024



5.3. OBJECT MENU

This menu includes various design-related editing options to apply to your photo.

5.3.1 ROTATE

This option allows you to rotate the selected (active) element on your page. You can choose between

90 degrees clockwise, 90 degrees counterclockwise and free rotation. The last option will show a

window enabling you to specify the exact number of degrees. This is useful if you wish to place

multiple elements on the same “slant”. When you’ve selected an element, you can always use the

blue ball to rotate it manually (with the mouse) as well.
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5.3.2. TRANSPARENCY

This tool applies a transparency level (in a percentage) to the selected or active object. You can also

select multiple objects at once. The transparency tool is not only for photos, but also for “text fields,”

“clip art,” “backgrounds,” and “shapes”. The higher the percentage, the more transparent the object

in question becomes. It can create beautiful effects as the tool also enables you to mix photos and

textures, for example by layering them and making both partially transparent. As a result, the photos

seem to merge together.

All backgrounds – except those from Photobox itself - are set to 50% transparency by default. If

necessary you can manually adjust this percentage by clicking on the background and changing the

transparency level from 50% to the desired percentage.
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5.3.3. TEXT MASK

Select a photo on your page. The photo will show a blue outline. Now click “Text mask” in the top

menu bar (also possible using the right mouse button “Create text mask”).

Enter your text and adjust the font if necessary. You can create two lines of text, one below the other.

The lines both share the same font.

Vary the transparency of the foreground and

background to achieve

different effects.

The image below shows five examples.

In the top left is the original picture, the one below

the transparency is 0% in the foreground and 100% in

the background.

On the bottom picture, the settings are 0%/80% (foreground/background).

On the top right, it’s 100%/0%, the one in the middle (right page) is also 0%/100% but the entire

picture is set to 50% transparency and finally the image on the bottom 0% in the foreground and 50%

in the background.

A shadow effect is another way of creating depth. To clarify: 0% transparency means that the image is

not transparent at all > The image is completely visible. At 100% transparency, the image is no longer

visible as it has been made completely transparent.
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5.3.4. COLOURED BORDER

This is a coloured border that you can place around your photo. You can choose from the default

colours, mix a colour, or use the eyedropper tool to select a colour from your photo. In the example

below, a shade of orange was selected from the image using the eyedropper. You can vary the

thickness (width) of the line, as shown in the top two images.

You could also experiment with the margin – the distance between the photo and the colour border.

The bottom two pictures give you an impression of the results. Note that the space between the

border and your picture is transparent, which means that the colour of the background is visible. In

this case, that happens to be white, but say you had a black background, for instance, the space

between the photo and the border would be black.

Using this tool, you can easily achieve beautiful, sleek and stylish effects.

A further option would be to create a shadow around the photos to add depth.
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5.3.5. CORNERS

Use this button to give your selected image rounded corners (see image below) or make them

straight.

5.3.6. SHADOWS

This tool will enable you to add shadows to an object. It allows you to choose the position of the

shadow (top left, top right, bottom left, bottom right), as well as its colour and size. Just click on the

paint bucket.

You could also add shadows to text, a shape, or clipart. By clicking “More…” you can select whether

it should also apply to all following (even/odd) pages.
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5.4. POSITION AND SIZE

5.4.1. POSITION

This tool allows you to determine the position of an object in relation to other objects. If you have

overlapping objects on your page, you can use it to specify which one should be in the foreground

and which in the background. Select an object by clicking on it and then choose "Bring Forward" or

"Move Back". Alternatively, choose a position using the right mouse button, option: “Position”.
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5.4.2. SIZES

The size options allow you to make the images on your page bigger or smaller. Some of the options

are greyed out in the menu as they only become available for use when you have selected (Ctrl +

mouse button) two or more images on the page.

Smallest – the selected images will be made just as small as the smallest image.

Biggest – the selected images will be made just as big as the biggest image.

Same Height – this option will make all selected images the same height. The reference point is the

height of the last selected image, i.e. the last image you clicked. You'll know which one it is by the

white dots in the blue outline.

Same Width – this option will make all selected images the same width. The reference point is the

width of the last selected image, i.e. the last image you clicked. You'll know which one it is by the

white dots in the blue outline.

Make Square – this crops an originally rectangular image – portrait or landscape – into a square. You

can use the white dot in the middle of the photo to move the crop if necessary.

Full Page Size – this will show the selected image full page on the active page.

Expand – this option allows you to spread the photo across both pages. You can adjust the crop using

the small dot in the middle of the photo.

Show Original Size – this feature restores the photo to its original length and width.

5.4.3. ALIGN

These options only become visible when you have selected two or more images on the page.

Align Left – all selected images will be left-aligned from the position of the last selected image. The

left side of this image will be used as the starting point.

Align Right – all selected images will be right-aligned from the position of the last selected image. The

right side of this image will be used as the starting point.

Align to Top - all selected images will be aligned to the top, starting from the position of the last

selected image. The top edge of this image will be used as the starting point.
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Align to Bottom – all selected images will be aligned to the bottom, starting from the position of the
last selected image. The bottom edge of this image will be used as the starting point.

TIP: if you select multiple images at the same time (outlined in blue), you will be able to move them
as a group with the mouse or keyboard without changing their position in relation to each other. Also,
to save time, you could edit the whole group of images together, for example adjust the transparency
levels, add rounded corners or a shadow, and your changes would be applied to all.

5.4.4. DISTRIBUTE

This tool allows you to distribute the images on your page. This option only becomes visible once you

have selected one or more images on the page.

The top row shows the images as they were originally spread out on the page.

In the middle row, the images are centred horizontally on two sides, with an equal amount of white

space on both sides. They are also evenly spaced horizontally.

In the bottom row, the images are centred on the page so that they are located exactly in the middle

of the page. They are also evenly spaced horizontally so that all distances are the same.
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The options:

Horizontally centred on page – this option centres the selected image or images horizontally on the

page. If you select multiple images, the entire group will be centred horizontally (equal space on the

page to the left and right of the selection). The distances between the images remain unchanged.

Horizontally centred across two pages – this option centres the selected image or images

horizontally exactly in the middle of the two pages, i.e. in the centre seam. Unless you are creating a

layflat photo book, make sure everything in the fold is still clearly visible.

Vertically centred on page – this option centres the selected image or images vertically on the page.

If you have multiple images selected, the entire group will be vertically centred (equal space on the

page to the left and right of the selection). The space between the images remains unchanged.

Distributed horizontally – the horizontal spacing between the (at least three selected) images is

equalised. The position of the outer two images remains the same. The space to the images in the

middle is adjusted.

Distributed vertically – the vertical spacing between the (at least three selected) images is equalised.

The position of the outer two images remains the same. The space to the images in the middle is

adjusted.

TIP: Holding down the "Ctrl" key on your keyboard will enable you to use the mouse to select

multiple images on the page by clicking them. Select all elements on a page by using the keyboard

shortcut “Ctrl + a”. If you then press “Ctrl + a” again, the elements on the adjacent page will also be

included in the selection.
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5.5. LAYOUT

5.5.1. RANDOM SHUFFLE and SHUFFLE WITHIN STYLE

Use these two buttons to let the software help you design your layouts. You will be able to choose a

specific style in which the photos will be arranged. The “Random shuffle” option will create a new

layout in the same style – or it could inspire you with something different.

The “Full Page” style is shown on the right and the “Playful” style on the left, using the same photos.

You could use the styles as an initial basis for your page and customise them or add photos later.
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5.5.2. MIRROR LAYOUT

This option allows you to mirror a layout from one page to another. The empty image and text frames

are shown mirrored on the adjacent page. You can now simply drag your photos into the frames.

Note: If you added masks to the images on your page, these won't be included.

As with saving your own layouts, applied masks are not taken into account when mirroring the page.

This option shows you the original image placeholder without applied masks.
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5.5.3. PROTECT AGAINST CHANGES

This button allows you to “lock” your page. When you select the page and click the "Prevent changes"

button in the top right menu, a small lock appears in the corner of the page. This prevents accidental

changes to the page. Click the button again to unlock the page. You will have to unlock each page

individually, both left and right pages. Only the cover of your photo book is seen as one page. On the

bottom corner of both pages a small lock icon will be visible when the page is locked.
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6. PHOTO BOOK AND PAGE MENU

6.1. ADD PAGES and DELETE PAGES

This tool will let you add additional pages, double page spreads only. The maximum number of pages

you can add and the ensuing additional costs are displayed in the popup. Select how many new pages

to add. They will be given a random layout unless you check the box to leave new pages blank.

If you have added additional pages (on top of the 24 minimum), you will also see the “Remove pages“

option. This allows you to remove pages you no longer need. You can also delete pages, again on

double page spreads – using the red cross at the bottom of the thumbnail overview bar.
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6.2. MOVE PAGES

You can move an entire double page spread to another place in your photo book:

The double page spread will be inserted at the place you entered, and the other pages will

automatically move up one page. You can also move (double) pages in the horizontal page overview

below your workspace.

6.3. CLEAR PAGES

This tool allows you to choose between the following three options with one click:
- Clear this page
- Clear this and all following pages
- Clear all pages (the entire photo book is cleared)
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6.4. SWITCH PAGES

This option allows you to exchange an entire page for another page of your choice.

This way, the content of page X is shown on page Y and vice versa.

You specify which pages should be switched and whether the content should be mirrored because,

for example, a given image might look better as part of a new double page spread.
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6.5. USE QUICK FILL

You can use quick fill if you want to speed things up and finish the book more quickly or need help
getting started with your photo book. Click on this option and the window below, depicting an
overview of your (still empty) pages, will pop up.

In the Photos tab in the left menu, go to the folder on your computer containing your selection of

photos for the photo book. You can drag them to the pages one by one, but you could also drag an

entire folder and then adjust them later. To do so, simply arrange the photos you would like to have

on one page next to each other.
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When you drag an entire folder into the book, a drop-down menu pops up:

In the menu on the right, select one of the available styles to fill the page. If you click “Save changes”

in the top left corner, the pages in the book will be filled with your photo selection. You can go on to

customise these layouts as you wish.

The following example shows what this will look like. You can check each page using the preview.

When you're done adding photos, you can go back to your book and customise each page. Add text
or additional photos using “Quick Fill”. You will be able to create a beautiful base for your photo book
in no time at all – without having to commit to any particular style at this stage.
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6.6. AUTO LAYOUT

We discussed our Photobox layouts in different styles in chapter 5.5. LAYOUT.
If you enable this option (by moving the slider to the right towards the green checkmark), you can
have the software automatically create a new layout based on the style you choose each time.
As soon as you add or remove a photo, the software creates a new layout and applies it to your page.
The image below shows the automatic layout activated.
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The left page now has 5 images and a new layout.

6.7. PAGE NUMBERS

This option allows you to add page numbers to your photo book. You can choose which font you want

to use, how big the numbers should be, and if you want them bold, italic or underlined. You can also

specify where the numbering should be on the page and whether you want it to be on all pages
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6.8. IMAGE ENHANCEMENT CURRENT PHOTO BOOK

You can change the default settings for image enhancement in the software using the previously

mentioned menu File > Settings > Image Enhancement (see 4.4.4.). This setting will then apply to

every new photo book you create from then on.

The "Image enhancement" option in the Photo Book & Page menu allows you to adjust settings

exclusively for the book you are currently working on. Your general optimisation settings – On or Off –

for a new photo book will remain the same as you set them as default via the File > Settings > General

menu.

6.9. CHANGE SIZE

This option allows you to change the size of your photo book. First, select another size. The software

will show you the available options. In the example, we chose a square XL book. You can only change

it into a square photo book in size Large. Be sure to check every page after changing te size.

This option is only for adjusting the actual size of the photo book. The selected format, in this case

square, cannot be changed into a portrait or landscape photo book as this would change the layout

on the pages too.
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6.10. OPTIONS

Say you are looking for a Lay flat Premium photo book instead of the regular binding, you can always

change the binding in "Options", provided the option is available for your chosen size of book.

7. CHECK & ORDER MENU

When all photos and texts have been included, the book has a cover, the spine a title and you've
carefully checked all pages one last time, your photo book is ready for printing.
This is where you'll use the last three tools in the horizontal menu bar: “Show warnings”, “Preview”
and “Order”.
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7.1. SHOW WARNINGS

This feature flags potential problems in your photo book. Examples include text that is too close to

the margins, empty pages, photos you have already used multiple times in your photo book, and so

on.

Always check for these warnings before ordering your book. You can then either choose to ignore

them or adapt your book accordingly. If you ignore the warnings and your book turns out less

beautiful than expected – well, you've been warned!
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7.2. PREVIEW

You can preview the photo book using the eye symbol, which you will find at the top of the menu as

well as on the bottom right of the Photobox software window. The preview shows what the page will

look like in print. Zoom in to see details and view your entire photo book in an automatic slideshow.

Below is an enlarged preview. You can zoom in and out using the wheel on your mouse or the slider

on the bottom left.

The preview is useful for checking that your text is easy to read, for example, whether your layout is

aligned correctly and if there are any edges or corners showing where you don't want them.

In short, this feature allows you to check the details. You cannot edit your photo book in preview

mode. To edit it, click “Close preview” at the bottom right.
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7.3. ORDER

When your photo book is good to go, click “Order”. As in the preview, you can click on the shopping

cart icon at the top of the menu bar or at the bottom right of the page. First, you may receive

warnings, as mentioned in 7.1. Then you can start ordering. All it takes is a few steps.

First, your order is prepared for shipping.

1/2 Preparing your order.

2/2 Sending your photo book.

The larger and heavier your photo book, the longer it may take. Of course, it also depends on the

quality of your internet connection. For a large photo book, sending may take 20 to 40 minutes. If you

have trouble sending it, try using a wired connection instead of Wi-Fi.

When we have received everything, the Photobox online shop opens in your internet browser and

you can log in. You can now select the number of (identical) photo books you want, select the glossy

pages option if you like and maybe order another, smaller, copy of the same photo book.

Next, we suggest a few other fabulous photography products to add to your order – that is entirely up

to you – and you can enter a discount code if you have one. Finally, enter your address and payment

details and complete your order.

If you wish, you can also request a link enabling you to view your photo book digitally and pass it on

to others. This option is ideal if you don't have your photo book with you but still want to show it to

people. It also comes in handy for sending the photo book (via email or social media) to family,

friends or acquaintances who aren’t around to look at your printed photo book in person.
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8. ICON MENU ON THE LEFT

This menu contains the icons you use and add most often.

You can actually create the entire book with only this menu. The individual tools are explained below

one by one from top to bottom.

8.1. PHOTOS

The top option in the menu is "Photos".

If you don't see certain folders or files, click the refresh icon (the 2 arrows next to the Photos tab).
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8.1.1. MOBILE PHOTOS TRANSFER

With this option you can download pictures from your mobile phone to your desktop without a wired

connection. For this transfer to work it’s important that both your mobile device and your computer

are connected to the same Wifi network. Make sure you give permission when asked.

Click on the button and a small screen opens. Click the green ‘Get started’ button.

Scan the QR code with your camera, click the link that appears on your phone. Always give permission

when asked. A screen opens on your mobile device, click the green button to start selecting your

photos. When you’re done selecting, click the ‘add’ button in the right upper corner of your mobile

device. When you transfer a lot of photos this might take a while.
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8.2. BACKGROUNDS

Photobox backgrounds are divided into different categories. You can use them in three different ways:

1. Drag to one page

2. Click on the desired background while the page is selected

3. Right click >> Apply

8.2.1. ADD TO FAVOURITES
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8.3. MASKS

The masks are divided into categories such as animals, Christmas, travel and music. You have the

option of creating a “favourites” category for them as well.

You can use masks in two different ways:

1. Regular mask

Select the photo you want to use for the mask. The photo will be outlined in blue.

Double-click your chosen mask in the menu (or right-click the mask in the menu “Apply”).

The white part will be visible as a photo, the black part will be hidden.

2. Inverted mask

Enable the “Apply mask inverted” option at the top of the menu. This will result in a

reversed cut out. The visible part of the photo then stays the same and the white area

has been removed.

The example below is showing the regular mask on the left and the inverted mask on the right.
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8.3.1. USE YOUR OWN MASKS

In addition to our standard masks included in the Photobox software, you can also use your own

masks, for example masks you have downloaded or even ones you have created yourself.

A mask is actually nothing more than a black and white, possibly grey image from which your photo is

cut out with high contrast. This means it can be a simple image with a black silhouette such as the

shape used in the example. When downloading a mask, make sure you pay attention to the quality of

the image.

Save your masks in a folder on your computer by adding a dedicated folder. Note: your own masks

will NOT be displayed among the Photobox masks.

Using custom masks is slightly different than using our standard masks. Please note: for masks

downloaded from the Internet the black part usually shows the photo and the white part is the part

cut from the photo, which is exactly the opposite of the masks in the Photobox software. Therefore,

you will have to use these masks inverted.

Go to the desired page in your photo book and click on the photo you want to apply the mask to. The

photo is now selected. Then navigate from the Photobox software (left menu) to the (photo) folder

on your computer where you have saved your own masks (it's basically the same as searching your

own photos in the Photobox software).

Then right-click on this mask and select Apply picture as inverted mask. You can now easily insert

(drag) other photos into the mask on your page. The (inverted) mask is then retained.

** Do not drag or click the mask image itself onto your photo (as you would do with a regular

mask), as this will replace the photo with the black and white mask image. **
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8.4. FRAMES

We offer a variety of frame categories and again you have the option of saving your favourites.

On the page of your choice, select the photo you want to frame by clicking on the photo, this will

then be outlined in blue.

Then select your chosen frame in the left menu, double-click it and the frame will be applied.

Alternatively, drag the frame onto the selected photo or hover over the frame in the menu (while

your photo is selected) and then right-click “Apply”. Just choose what works best for you.

Frames also define the shape of your image. They cut it out, just like masks – see the following

example depicting the same photo with two different frames.

Use the “Border” slider to give the image a picture mount effect in the frame. A sheer space will then
show between the frame and the image.
If you have given the page a coloured background, this background will remain visible since the space

is transparent.
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8.5. CLIP ART

The illustrations in the software are called cliparts. These come in many different categories and, as

before, you have the option of saving your favourites.

Simply move them from the left menu to your photo book by dragging or double-clicking.

Double-clicking on the clipart or right-clicking “Edit” will take you to the editing menu. Options here

include changing the clipart to black and white or a negative, or even adjusting the colours by playing

with the light, contrast and colour levels.

In the example on the next page you see the different results you can get when editing the cliparts.

The original is shown on the left and the edited version of the same clip art on the right.

1. The quote was originally black, but right click > Edit > Effects > Negative transformed it into a

negative.

2. Various aspects of the bear were adjusted using the sliders using right-click > Edit > Light,

contrast and colour. This allows you to coordinate your chosen clip art with your photos or

other elements on the page.

3. The house was changed to a black, white and grey version using right-click > Edit > Effects >

Black and white.

4. The flowers became sepia using right-click > Edit > Effects > Sepia.
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Sometimes clipart simply isn't the right size for the look you want.

If you stretch the clip art on one side, part of the outside will disappear from the placeholder because

the software maintains the length x width ratio, as seen in the image below. The first image is the

original image, the second has been made smaller by dragging the white handles on the side. You can

see both sides of the image look cut off. However, if you wish to distort the image, just right-click on

the clipart and select the “Allow stretching of image” option. You can see the result in the third and

fourth image in the screenshot below. The image is stretched in width but is still fully visible.
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One clip art category that deserves special attention is the Colours category.

A slightly unexpected category, but you may well end up using it a lot. It contains circles and squares,

which can be stretched into rectangles, in multiple colours. All for you to use however you like to

creatively design and decorate your photo book – and you can even apply masks to them.

8.6. SHAPES

Shapes are a type of clipart you can customise to your liking. These are not masks and you cannot
insert photos. Arrows, hearts, frames, text clouds are just a few of many inspiring options.

Drag or click on your chosen shape to add to your page and a menu will open.

You can now select an outline that follows the shape in your chosen colour and width. We chose a
dark frame for the quarter circle on the bottom right.

For the shape itself, you can either choose one colour or apply a gradient of two different colours to it
(as standard or using the colour eyedropper as in the example). If you've chosen a gradient, you can
choose a second colour for your shape and add a shadow or transparency. You can also move it
partially over the edge of the page if you only want to see part of the shape.

Tip: Only on the rectangular shape it’s possible to apply masks as well to give your colour or gradient
of choice any shape you want by using the masks from the Photobox editor or one of your own.
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8.7. LAYOUTS and MY LAYOUTS

You could insert each new photo into your book as a new element, and then resize and arrange them

individually. But there is also an easier way.

Some layouts come fully designed with the software. You will find them in the “Layouts” tab. This

allows you to choose how many photos to arrange on each page (1, 2, 3, 4, 5, and > and mosaic), and

you can choose from a range of standard layouts.

Double-click the layout and it will show on the page you selected. If there are already photos on the

page, they will be automatically inserted into the fields. If the page is still blank, you can now simply

move your photos into the various empty fields.

Alternatively, you can also easily customise existing layouts. As soon as you're happy with the

tweaked layout of your page, you save it. Click “My layouts.” At the top of the menu you will see

“Save layout”. Click there and the layout (of the active page) will now show in the list of your own

layouts.

You can also delete your saved custom layouts by clicking on the three dots or by right-clicking on the

custom layout and selecting “Delete”.
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9. EDIT OBJECT (RIGHT MOUSE BUTTON)

Depending on your settings, you can double-click an object (background, photo, clip art) or right-click

to open the menu window that appears below. You can also click on the little pencil that appears

below the image.

The edited photo will then show in your photo book. All options are explained below.
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9.1. ROTATE LEFT OR ROTATE RIGHT

This option rotates an object 90 degrees to the left or right. When you're happy with the result, click

“Apply action” and return to your photo book.

9.2. BRIGHTNESS, CONTRAST AND COLOUR

Use the sliders in this menu to set different colour and exposure levels.
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9.3. CROP

This allows you to crop your photo within a fixed shape such as the rectangle in the example below,

an ellipse, or the shape of the photo itself – and you can even use your mouse to "cut" your own

shape by hand. Click “Done editing” when you're ready to return to the photo book.

9.4. ALIGN HORIZON

It happens to all of us. When you’re taking a picture, you don’t always get the horizon level straight.

Fortunately there is a practical and user-friendly tool for this common issue.

Simply draw a line over the current horizon in your photo, click “Apply action” and the horizon will be

aligned.
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9.5. ROTATION CORRECTION

This option allows you to rotate the image on a grid. If a photo doesn't have a clear horizon, but you

would still like to align it along horizontal or vertical lines, you can do so by using your mouse to click

on the photo and rotate or with the “right” and “left” arrow keys.

9.6. FLIP HORIZONTALLY and

FLIP VERTICALLY
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9.7. RED EYE REMOVAL

Another common issue is the red-eye effect caused by flash photography. Red eyes can be easily

removed with this tool.

Click “Edit” (right-click or double-click) on the photo, then go to “Actions” > “Remove red eye”. A

round selection frame will appear, which you can move and enlarge to get an exact fit with the red

part of the eye you want to adjust. Click Apply and repeat the process for the other eye.
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9.8. REMOVE COLOUR

This option allows you to select and remove one or several colours from a photo. Hold down the

“Shift” key and use the mouse to select the parts you wish to remove. You can click as many times

and select as many parts of the photo as you like. If you accidentally make the wrong selection,

simply hold “Ctrl” and click to deselect.

When you click “Apply”, the selected parts will be removed from the photo and become transparent.

In the picture below you can see an example of what you can do using this option. By cutting out the

sky, you can now place elements behind it. In this case we used a text mask to appear from behind

the mountains, creating a nice effect.
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9.9. KEEP ONE COLOUR

Use this option to select and keep an area of one or several colours while transforming everything

else into black and white. Hold down the “Shift” key while using your mouse to select your colour(s).

Click and select as much as you like. If you accidentally make the wrong selection, simply hold “Ctrl”

and click to deselect. In the menu you will find three additional options.

Once your selection is complete, click “Apply action” in the top left of the menu bar. The image on the

left page shows the result and the original image is on the right.
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9.10. EFFECTS

Transform your photos using a special effect. You have a range of options to choose from like

negative, sepia, colour filters, drawing and X-ray. Simply click the one you want:
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9.11. PLUG-INS

The “Edit” option (depending on your settings: double-click or right-click) gives you access to the
editing menu. The last tool in this menu is “Plug-ins”.

A plug-in is a software component that is added to a programme to expand its functionality, in this

case it enables you to edit your photos.

There is a whole range of different plug-ins available, and they all have loads of useful features.

In the next chapter of this guide we will introduce three plug-ins that make photo editing even more

fun. Of course you don't have to use them, it's really just a matter of what you like or need and what

you think is suitable for your photo book.
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10. EXTRA – FOCUS ON PLUG-INS

The Photobox software includes various plug-ins. Read on to discover three of our favourites below.

10.1. PLUG-IN – AAA BLENDER

This plug-in can be loaded directly from the Photobox Windows Editor. You can use it to create a

border around a photo or to blend two photos.

Below you'll find an example explaining the various steps.

Loading the plug-in:

· Select a photo in the Photobox software and go to “Edit”.

· Select “Plug-ins” and then “AAA Filters -> AAA Blender”.

· Click “Open Layer” and navigate to the Photobox software folder and then Plug-ins ->

Landscape -> AAA Filters to see what is in there or even better, select an image anywhere on

your computer you want to blend with and click “Open.” You can use patterns, backgrounds

and photos. In this case a striped pattern is used to create a nice border.

· Adjust the frame width using the Frame Size slider.

· The “Opacity” slider adjusts the frame transparency.

· Use the R, G, and B sliders to adjust the frame colour(s).

· Clicking “Normal” opens a drop-down list with various options. For example, the “Dissolve“

option gives the frame a grainy effect.

· When you are happy with your frame, click the “OK” button, then click “Editing done” in the

photo editing window.

67

Photobox Windows editor manual - Last modified 12 aug 2024



10.2. PLUG-IN – WIRE WORM

Wire Worm is a handy tool for removing unwanted objects in a photo. It is not available in the

Photobox Windows editor but can be found online using the keyword “Wire Worm”.

Here’s the link if you fancy giving it a try: Make sure you click the right button before downloading as

the website is quite extensive.

Download the 32-bit version of the plugin.

If you double-click an image in the Photobox software to go to photo editing, click "Plugins" and then

click "Load More" the dialogue field will display the folder with the Photobox plugins.

Extract the downloaded zip file into this folder and start the Photobox software. Under the “Plug-ins”

button you will now find “MV’s plug-ins” with “Wire Worm”.

Don't forget to check out the sample videos and photos on the website you downloaded the plugin

from for explanations.

In short:

- The red square in the small image on the bottom right shows which part of the photo you are

currently editing. The selection has been enlarged in the larger image on the left. Move the

red square frame over the small image to edit a different part of your photo.

- In the large image, drag a line over the object you want to remove, then move (drag) the

selection to the part of the photo you want it to look like. In this case you could go up.

- Use “Radius” to enlarge the selection. With “Undo” you undo the last change.
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In the picture below you can see the result of our adjustments in the right image. The upper part of

the barbed wire has been completely removed.

TIP: This tool is very useful for removing elements like power lines or stains that you would rather not

have in your photo. Larger objects can also be removed, but this often requires several steps.

Below are some other examples of the objects removed with this plugin.
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10.3. PLUG-IN – XERO

The final plug-in we would like to introduce you to is Xero. This one comes with a wide range of

artistic options.

In the following example we are using the Line art option, which creates a pen drawing of your photo.

Double-click or right-click your image to “Edit” and then “Plug-ins” > “Xero”.

Now enter a series of values until you're happy with the result. We have chosen black and white

(monochrome). As with all plug-ins, have fun playing around with the settings to see what effect they

have on your image.
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11. EXTRA – USING FONTS AT PHOTOBOX

The Photobox software uses the fonts that you have installed on your computer. If you would like to

use a new font in your photo book, you need to install it on your computer first.

The Photobox software itself does not contain any fonts.

To introduce a new font first go to a website where you can download fonts. You could purchase one

but with the huge selection of free fonts at your fingertips this probably won't be necessary.

Here are a few websites for downloading fonts:

https://fonts.google.com/

https://www.1001freefonts.com/

https://www.dafont.com/

Installing fonts

A font is downloaded as a zip file, usually by using the “Download” button. Once your download is

complete, go to “Downloads” on your computer, extract the file and save it to your fonts folder.

The folder usually contains several files and often comes with a preview image or an overview image

in jpg format.

The .ttf or .otf files are the actual fonts. Double-click it or right-click and select “Install.” You may have

to restart programmes before the new font becomes visible. You can then use the installed font in

other programmes such as Microsoft Word as well.

Whether you need a .ttf or an .otf depends on the font you choose. For most fonts the .ttf is

sufficient. However, the .otf set often provides expanded design options. For example, there are

certain fonts that come with all sorts of extras, such as special characters or swash glyphs with

decorative flourishes.

If you can't find the installed font in the Photobox software even after restarting the programme, go

to “File” > “Settings” > “General” and then uncheck: “Show only True Type fonts for text editing”.

Please note: some of the free fonts do not contain the complete character set as shown in the

preview. Sometimes these are demo packages that do not always contain punctuation or numbers.

If this is the case, you will probably see a logo instead.
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12. TIPS & ADVICE

Creating a photo book can take up a lot of time and energy. So, imagine how frustrating it would be if

something went wrong and your photo book could not be located or saved, not even by the Photobox

team.

That's why we advise you to always save your photo book in another location in addition to the

regular location of your photo book.

A suitable location could be an external hard drive and/or somewhere in a cloud – this way, your

photo book would be safe if anything happened to your computer.

If you experience any problems with the software, please always contact customer support and

submit your bug report when the system asks for it.

This is the only way Photobox can identify and correct any problems and errors in the software.
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